
OmniCon 3.0
What OmniCon is
          - Explains what OmniCon is and what OmniCon does.

How OmniCon is different
          - Tells you why you're better off using OmniCon rather than ANY other conversion program.

How OmniCon is useful
          - Explains what kind of people would find OmniCon useful, and why.

Features of OmniCon 3.0
          - Lists some of the features of the program.

A bit of the history behind units
          - Tells you a tiny bit of the way units developed.

Instructions
          - Gives detailed instructions on how to use OmniCon.

Contacting the author
          - How do I get in touch with Phil in order to tell him about some stupid bug he's incorporated into his 
little program?

Version History
          - Version History of OmniCon

Registration form
          - What it is and why it benefits you and I.



What OmniCon is
          OmniCon 2.0 is a very useful and powerful program that allows the user (that's YOU!) to convert any
unit of virtually any physical quantity into another unit of the same quantity.    In other words, it allows you 
to very quickly convert between teaspoons and tablespoons, litres and gallons, or torr's and psi's.    I have 
included practically every physical quantity (such as volume, mass, length, time etc.) known to man, and 
within those quantities, I've included many, many units.    
          OmniCon provides you with a simple and convenient way to interchange between these units very 
quickly with a high degree of accuracy (actually, in most cases, it's up to you to pick just how accurate you
want the result to be since there are sometimes 10 decimal places staring you in the eye!).    Anybody that
uses physical quantities in their field of work will find OmniCon invaluable.    



How OmniCon is different
          There are a lot of conversion utilities out there, but NONE can match the ease-of-use, the speed, 
and the breadth of OmniCon.      OmniCon is super-easy to use, very powerful, and offers many 
conveniences to the user.    I wrote OmniCon because I'm in a science program at university, and I find it 
a BIG pain in the butt to always have to look up conversion formulae and factors in order to convert units 
back and forth.    OmniCon gets away from all of that hassle.    You simply choose a physical quantity, 
indicate what unit the initial value is in, and choose the unit you want the final value in.    PRESTO!    
You've got your converted value!    It's very easy, convenient, and a REAL time-saver if you're ever doing 
many (or even a few!) conversions!



How OmniCon is useful
          Many people, ranging from doctors, scientists, homemakers, engineers, teachers, and students to 
surveyors, architects and computer nerds are potential users of OmniCon because their daily lives often 
involve conversion.    
          Students can ALWAYS find something to convert (or their teachers can GIVE them something to 
convert!), and engineers breathe conversion.    Just think how useful and easy it would be to just tap in a 
couple of numbers to instantly convert between one unit and another.  This power is right here in 
OmniCon.    



Features of OmniCon 3.0
          There are many features in this program; some of which are listed below:
            ability to choose which units you want available!
· ease-of-use - OmniCon is THE easiest converter to learn how to use.    The format is basically self-

explanatory, and most users do not need ANY explanation (including this help file - am I wasting my 
time?).

· functionality - OmniCon is very versatile - handling quantities such as length, time, and mass as well 
as conductance, capacitance, and dynamic viscosity - ALL with MANY units.

· always-on-top - All of the screen elements (the main window, the small window, the metric prefix 
table, and the physical constants table) have always-on-top capability that can be switched on or off 
at your convenience. (See Always on top)

· a "small" screen - Since the program is designed to be used in conjunction with other programs such 
as graphing programs or spreadsheets, the data can be represented in a very tiny box - wherever you
want it, so that you see the results of your conversion as well as the "other" program at the same 
time. (See Small View)

· a metric prefix table and a physical constant table - With one click of the mouse, you have access to 
ALL of the metric (SI) prefixes as well as many physical constants so that you can speed up your 
work (See The Metric prefix table and the physical constant table)

· instant updates to calculations - If you change a unit, the result is INSTANTLY updated.    There is no 
need to click on a "Convert" button to have the calculation take place.    This makes you work even 
FASTER!

· copy and paste capabilities - Copy a number from a spreadsheet to OmniCon, convert it and then 
ship it out again - all with a couple of keystrokes!! (See Copying and pasting)

· right-button functionality - The right mouse button is fully implemented to allow you to work quickly - 
there's no need to ALWAYS go up to the main menu to access the most common functions.

· full representation of SI and imperial units - Instead of  (A^2 * s^3 / kg * m^2)    you get    (A² · s³ / kg
·m²)  - isn't that a lot nicer?

· a clock    - that is able to turn on/off at your command (in order to watch the time carefully while you're 
preparing your final term paper on conversion methods!). (See Clock)

· formattable results - YOU can decide how many decimal places YOU want the output to have (this 
allows you any degree of accuracy that is needed, and not 5 trailing decimals to get in the way!). (See
Formatting output)

· user-configurable 'shell' program - If you suddenly forget what 2x5 is, then just two clicks will (by 
default) bring up the calculator for some quick calculations . Or, you can set it up so that your 
favourite PIM is loaded.    Whatever you want! (See Calculator)

·       INI file - OmniCon v2.0 remembers where your window was on the screen, whether the clock was on 
or off when you exited the program, how many decimals places you wanted, whether or not you want 
the tables to be pre-loaded or not (preloading saves a bit of time if you're constantly calling on these 
windows, but it also eats up more resources), and what application you'd like to start when you click 
on "Run Shell Program..."



A bit of the history behind units
          Everything we produce and consume, everything we buy and sell, and everything we see and feel is 
measured and compared by means of units.    Units enable us to measure the distance we walk, run, or 
RollerBlade®, the land we own, the time of day, and the brightness of the stars.
          Some of these units have become so familiar to us that we take them for granted, seldom stopping 
to think about how they started, or why they were given the names which they now bear and the sizes 
which they have.
          Centuries ago, the foot was defined as the length of 36 barleycorns strung end to end, and the yard 
was the distance from the tip of King Edgar's nose to the end of his outstretched hand!    The sun and the 
moon gave a precise measure of time, but for years the units of volume and weight were in a state of flux 
and confusion.
          Since then, we have come a long way in standardizing our units of measure and weight.    Many 
standards are now based upon the physical laws of nature, which are reproducible, invariable and neutral.
The yard and metre are now measured in terms of the wavelength of light, and time by the durations of 
minute atomic vibrations.    This improvement in our standards of measure went hand in hand with the 
advance of technology, and the one could not have been achieved without the other.    
          But, even though the basic standards of reference are now recognized by all countries of the world, 
the units of everyday measure are FAR from being universal.    In many (most) countries, the unit of length
is the metre, while in some it is still the yard.    Astronomers enjoy the parsec, physicists use the angstrom,
and surveyors use the rod and chain.    But these units of length can be compared with great accuracy 
because the standard of length is based upon the wavelength of light.
          Such standards of reference make it possible to compare the units of measure in one country, or in 
one speciality, with the units of measure in any other.    Standard units of length, mass and time are the 
anchors which tie together the different systems of units used in the world today.
          Over the years, systems of units have been devised to meet the needs of commerce, industry, and 
science.    In the English system of units, the inch, foot, and yard are related to each other by the numbers
12, 3 and 36.    And again, in the same system, the ounce, pound, and short ton are related by the 
numbers 16, 2000, and 32 000.
          The same correlation between units exists in the Metric system of measure, except that all units are 
related to each other in multiples of ten.    Thus, the centimetre, metre and kilometre are related to each 
other by the numbers 100, 1000, and 100 000.    It is therefore easier to convert metres into centimetres 
than it is to convert yards into feet.
          The English system is very old, and its origins may be traced back to the time of the Egyptians.    By 
comparison, the Metric system is a newcomer, having been started only about 175 years ago.
          The premise behind the Metric system is that once the prefixes to the units are known (such as centi,
milli, deca, etc.) then all of the other units can be derived from them.    Therefore, in this program, some of
these units are omitted because of simplicity.    (It is rather trivial to convert centimetres into metres or 
millimetres if a table is provided, which in this case, it is.)
          Well, there you go, a brief but interesting (??) portrait of units of past and present.    Hope you 
enjoyed it, but let's get on to the main event eh?    (Sorry, I'm Canadian!!)



Instructions
          OmniCon 3.0 is so easy to use I seriously doubt that anyone will need this, but just in case, here 
she goes!

Starting out

Your first conversion

Copying and pasting

The Metric prefix table and the physical constant table

Always on top

Small View

Formatting output

Clock

Calculator



Starting out
          When you first execute OmniCon, you will see the main window.    

This is where most of the action goes on.    Along the top is the menu bar which provides access to six 
menus that perform many functions.
          The File menu provides a nice way for you to get the heck out of OmniCon when you need to go 
pick up your kids/hand in your thesis etc.
          The Edit menu allows you to copy values out of the result  box, and paste values into the initial value
box.    [Please don't fret because of these names - their names are trivial as you will have noticed if you've
already looked at the screen.    The difference between the result and the initial value boxes is that the 
result box does not accept input (i.e. you can't type a value to be converted there!).    The result box only 
displays results, therefore it is the initial value box that you will enter to ready-to-be-converted values into. 
Sound difficult?    It really isn't.]
          The View menu allows you to view the Metric prefix table and the physical constant table so that you
can do some quick Metric conversions in your head, or so that you can see if Planck's constant is really to
the 34th power or not!
          The Always On Top menu allows you to make the main window "float" on top of every other window,
so that you can copy in a number from a window you're looking at, convert it, and re-enter the new 
number onto your spreadsheet without switching back and forth between applications, or resizing a million
windows to get them all arranged perfectly!
          The Small menu gives a small representation of all the information contained within the main 
window in a small box that is movable to any part of your screen. This gives you even MORE space to 
work with!    Try it to see what I mean.
          Just guess what the Help menu does!!!

          On the main window, you will see three drop-down boxes and two blue boxes.    The drop down 
boxes allow you to choose a quantity (volume, mass, length etc.) and the other two allow you to select 
which units you want to convert between (i.e. centimetres to feet, kilometres to miles etc.).    

          That's basically all there is to it!

Click on Back to figure out the rest of this program!!





Your first conversion
1. To perform your first conversion, click on the drop down box below the label "Select quantity".

Fig. 1 - The "Select quantity" drop-down box

    Scroll down until you see "Length" and click it.
2. Now click on the first drop-down box labelled "Select initial unit:" and choose metre.

Fig. 2 - The "initial unit" drop down box

3. Click on the drop-down box labelled "Select final unit" and choose foot.
4. Enter in a value for metres in the box adjacent to it (i.e. the initial unit box).    Say maybe 10 metres.

Fig. 3 - The "initial unit" box

5. There you go, YOU'VE DONE YOUR FIRST CONVERSION!!!
6.      If you now change either of the drop-down boxes (i.e. change either the initial OR final units), then 

the calculations will immediately reflect the change.    Try it by changing metres to yards and then feet 
to inches.    The values will INSTANTLY change to reflect the new units!



Copying and pasting
          The copy and paste features of OmniCon integrate it well with other applications.    Say, for instance,
you're doing some work on a spreadsheet.    You have a value for kilometres that needs to be switched 
into miles.
              First, you select the value in your spreadsheet that is in miles, and then you paste it into 
OmniCon.    In order to do this, the first drop-down box would be in kilometres, and the second drop-down
box would be in miles.    When    you select Edit/Paste from the menu bar, (or, click on the right mouse 
button and select Paste), the value (in kilometres) is pasted into the initial value box, and the 
corresponding value in miles is calculated and then displayed in the result box.    
          If you were to now select Edit/Copy, (or, again, click the right mouse button  and select Copy), the 
value for miles (i.e. the result box) would be copied to the clipboard.
          So, in review, the Edit/Copy function copies the value from the result box to the clipboard, and the 
Edit/Paste function pastes the value on the clipboard to the initial value box.    Try it a few times to get 
the hang of it.
          Another quick way of copying and pasting (besides the already convenient right mouse button 
method) is to double-click the result box or the initial value box (to either paste or copy, respectively).



The Metric prefix table and the physical constant table
          The metric system is generally easy to use - IF you can remember all of the prefixes!    In order to 
help you with this arduous task, I've included a prefix table to help you.    At any time, you can click on 
View/Metric Prefix Table...  to see all of the prefixes and their corresponding powers of 10.    This window
allows you to select either the full table or just a part of it that is scrollable so that it takes up less screen 
space.    This window also has an Always on top feature.    To get back to the main window, just click on 
Back...    
          You can also access the Metric prefix table using the right mouse button.    Just click the right 
mouse button anywhere on the main window, and select the option you want.

Fig. 1 - The metric prefix table

        

            Another table that is included is the physical constant table - which shows you many fundamental 
constants of nature that you can use as a quick reference in your work (for all you scientists/engineers out
there - I'm thinking of you!).    Again, you can either access this window by using the menu bar      
(View/Physical constants) or by clicking the right mouse button anywhere on the main window.    This 
window is also scrollable or available as a full table that takes up most of the screen.    Your choice...

Fig. 2 - The physical constant table

          Double-clicking on any of the constants will copy that value to the clipboard!!    This is potentially very
useful.    If you need the value for Pi to 10 decimal places and don't feel like copying it all out, then just call
up the physical constants table and double-click the value (in the 2nd column) for Pi.    Its value will be 
copied to the clipboard, and you can then paste it into OmniCon to perform a conversion on it, OR you 
can paste it into any other application to perform ANY operation on it (use it in text, spreadsheet etc.)..



Always on top
          The always on top feature is available for all of the main windows ( the main window, the metric 
prefix table, and the physical constant table) within OmniCon 3.0.    For instance if (while working on a 
spreadsheet or in a word-processor) you wanted to do many conversions while keeping the other 
application in view, you could just click on Always On Top/On, and the main window of OmniCon would 
always be visible.    This is very useful, so try and make the most of it.    This feature virtually eliminates 
having to switch back and forth all of the time between several application to find the one you want!



Small View
          This feature is very useful if you just want a small display of the quantity, units, and values that you 
have converted.    If you use this (by clicking on Small... or by clicking the right mouse button on the main 
window and clicking Small... then you will get a very small window that is movable to anywhere on your 
screen that will always stay on top.    Useful if you want to copy some information into another 
application... but always forget what the values were!    One click of the mouse on the white area beneath 
the title bar, or a press of the "Esc" or "Enter" keys will return you to the main window. 

Fig. 1 - Small view

NOTE:    Small view is ONLY available when your screen resolution is less than or equal to 640x480.    
(The reason for this is that most users with resolutions greater than this (i.e. 1024x728) could easily tile a 
spreadsheet and OmniCon on their screen, whereas it's MUCH harder on a lower resolution (i.e. 
640x480)).



Formatting output
          If you don't like the way the numbers look when they're calculated (i.e. the resulting number has 3 
decimal places!!), then you can change this by specifying the number of decimal places that you would 
like the output to have.    To do this, just click on the menu File/Options/Numeric format menu and 
specify how many you would like.    Also, the limit of decimal places is 3...This is because of the accuracy 
of the info that I designed OmniCon with (the information for creating OmniCon v2.0 was taken from 
tables that I received from the Government of Canada)..
          To do this, either enter in a number manually from the keyboard, use the Up/Down cursor arrows to
move the number displayed up or down, or click on the "+" or "-" buttons to change the number.    
When you have finished, just click on OK and your numbers will now have the correct number of decimal 
places.    
          TECHNICAL NOTE:    If the calculated result is larger then 1x E9 (i.e. 1 billion), or less than 1x E-3 
then the result automatically defaults to scientific notation (to save space!).    However, you can still control
the accuracy of your result - when in scientific notation, the number of decimal places gives the number of
digits BEFORE the exponential sign (E).    Therefore it is the same thing as specifying the number of 
decimal places that you would like.



Clock
          The clock function in OmniCon is only for your convenience.    In order to turn the clock OFF (the 
default is ON), just go to the File/Options/Clock main and select OFF.    Or, if you want a faster way, just 
double-click the OmniCon icon:

    and it will disappear.    In order to turn it back on, just double-click on the OmniCon icon again or use the
File/Options/Clock routine.



'Shell' Program
        If you need to perform a calculation or two, just click on View/Run Shell Program to bring up the 
generic Windows calculator, or whatever program you wish.    (SHORTCUT KEY:    Ctrl & R)



Contacting the author
          It is not hard to contact me.    My name is Phil Jones, and here are my addresses:

Postal:                                                                                                                                                           E-Mail:
117 William St. Unit #1                                                                                                        3pmgj@qlink.queensu.ca
Kingston, Ontario
CANADA
K7L 2C7

                Please feel free get into touch with me if you have any problems, bugs to report, or 
suggestions/comments for the next version.    I will get back to you as soon as possible if you leave me e-
mail.    I'd love to hear from everyone that uses this program- whether they decide to register it or not.    
Thanks again for evaluating OmniCon 3.0!!

                                                                                                                                                         Phil



Version History
      This is the second version of OmniCon.    

Version 1.0a: June,1994
a) Changed clock so that no flickering when updated (i.e. EVERY second!).
b) Added registration key to Registered version.
c) Changed scrolling algorithm altogether to use less system resources and speed scrolling up.
d) Updated Help file so it now allows browse sequences and searches.

Version 1.0b: July, 1994
a) Added INI file support for preloading of metric and physical constant forms to save system
resources.
b) Added INI file support for the clock (on/off), the numeric formatting setting, and the main
window position on the screen.
c) Changed dialog box so that all options (except for clock on/off) are set form one main options
dialog.    Added the ability to select which program would run when CTRL-R is pressed. (Instead
of forcing Windows Calculator applet.)

Version 1.0c: September, 1994
a) Fixed a few minor bugs, changed max. number of decimal places to 5
b) added "Help with Help" menu item

     Thanks!

Contacting the author



Registration form
          There are many opinions concerning the "Shareware concept".    Personally, I think it's great that 
people can try out software that they may potentially like before they actually buy it.    However, the 
system ONLY works if everybody plays fair.    A lot of work has gone into this program, and I wouldn't like 
to think that hundreds of people were all using it for free.    The price is NOT expensive ($20 CDN or U.S. 
funds), and for your money, you get quite a bit of code.    I will uuencode this program (upon receiving 
payment through the mail) and send it to all registered users so that the Shareware "nag" screen is no 
longer present and I will also add any units/quantities that you may wish.    If I have to send you a disk 
through the mail, there will be an additional $5.00 fee to cover mailing expenses and disks.    So, it's a lot 
easier to get them through the I-Net if you have access.    I accept cash or cheque.    I imagine that for 
most users a post-dated cheque would be sufficient security that I will not snake you into sending 20 
bucks and not receiving any disks.    In this case I would suggest post-dating the cheque for around three 
weeks after you send it.    In most cases, you will have your disks even before I cash the cheque (again, 
I'm trusting you) depending on Canadian and other postal services.
I thank you for your integrity, and hope to hear from you soon.

Registration Form

NAME:______________________________________________________________________________
________
ADDRESS:___________________________________________________________________________
________
PROVINCE/
STATE:_____________________________________________________________________________
POSTAL/ZIP CODE _______________________________
COUNTRY:______________________________________
TELEPHONE NUMBER: (      )          -                                                                                                              
e-mail address _______________________________

METHOD OF SHIPMENT: 
 ( )    3.5"    DISK    @ $20 (CDN or U.S. funds) + $5 S&H__________________
 ( )    5.25" DISK @ $20 (CDN or U.S. funds) + $5 S&H __________________
 ( )      UUENCODE THROUGH INTERNET @ $20 (CDN or U.S. funds)__________

SEND TO:
                             Philip Jones
                              117 William St. Unit#1                                                                                      Total:$___________
                                Kingston, Ontario
                                CANADA
                                K7L 2C7

Thank you for your order!




